


Что такое этот веб?

Я не имею ввиду что такое 
веб с технической стороны. 
Это мы оставим людям, у 
которых математический 
уклад мозга. Я вебмастер 
и юзер веба. Создаю сайты 
и захожу на сайты. Что веб 
для меня? Я могу описать 
очевидно и размыто, типа 
это вселенная, живущая по 
своим правилам виртуальная 
реальность. Эта реальность 
находится на сайтах, но сами 
сайты сложно найти, для этого 
нужна поисковая система или 
каталог разбитый на тематики, 
а лучше сортированный по 
популярности! Бла бла бла…

Прежде чем ответить, что 
такое веб, нужно пройти 
через него, попробовать на 
вкус. Как обычно начинается 
мой путь к новым сайтам? Я 
призадумаюсь о том, что бы 
я хотел такого найти в вебе, 
потом введу свой запрос в 
Яндекс и кликну на одну из 
ссылок, которая показалась 
мне интересной.

Тут может быть 2 варианта 
развития событий. Я найду 
что хотел, потом перейду на 
другие страницы этого сайта, 
в надежде найти что-нибудь 

еще эдакое. Может быть 
такое, что с 2011 года ничего 
нового не выкладывали на 
сайте или же наоборот, увижу 
много новых материалов. Но 
это не очень влияет на мое 
решение уйти или остаться, 
или даже возвращаться на 
данный сайт. Мне нужно 
иметь связь с сайтом, он 
должен предложить мне 
какие-то долгосрочные 
отношения. Иначе я точно 
уйду и забуду про него.

Теперь скажу со стороны 
создателя сайтов, нужно 
создать ожидание. В этом 
секрет и телевидения 
прошлого и веба прошлого, 
даже игр.

Почему сайты Mamba и 
Одноклассники так сильно 

затягивали пользователей в 
2006 году? Только подумайте, 
если Mail.ru, Rambler, Яндекс 
использовались в основном 
ради почты и поиска сайтов, 
то с этими новыми видами 
сайтов, социальными 
сетями, все изменилось. 
Хоть человек и социальное 
существо, но не каждый сайт 
для общения его удержит. 
Так что же такого сделали 
Одноклассники и Mamba, 
что к ним прилипали и о них 
говорили все. Узнать можно, 
только если пользоваться 
старыми версиями этих 
сайтов. К счастью я могу 
просто поделиться с вами 
воспоминаниями.

Одноклассники
Первое знакомство с любым 
сайтом начинается с его 
главной страницы, даже если 
попали на его внутреннюю 
страницу через поисковую 
систему. Чтобы узнать больше 



об этом сайте, придется 
перейти на его главную 
страницу.

Что было на главной странице 
сайта Одноклассники? Форма 
входа и огромный список 
стран и городов в виде 
ссылок. Человек высматривал 
в этом списке свой город. Из 
этого списка находил свой 
город и нажимал. Дальше 
выводился список школ с 
вопросом «В какой школе вы 
учились?». Последний третий 
шаг, это заполнение имени, 
фамилии, года рождения и 
года выпуска из школы.

Сразу после регистрации 
ты появлялся у своих 
одноклассников, как 
найденный одноклассник 
и сайт предлагал 
подружиться с тобой. А 
ты сразу видел список 
всех своих повзрослевших 
одноклассников. То есть с 
помощью выбора, который 
дает сайт, можно создать 
уникальный, именно для 
конкретного человека список 
людей или другого контента. 
В этот момент завязываются 
отношения с сайтом. Крючек 
проглочен, поймете в конце 
статьи.

И не нужно как 
сегодня делают соц. 
сети, использовать 
рекомендательные системы. 
Человек сам готов и рад 
нажимать и вводить данные, 
ради момента, когда он 
найдет именно то, что искал.

Mamba
Сайт знакомств, многие 
считают, что залогом успеха 

стало то, что практически 
все самые популярные 
порталы рунета участвовали 
в партнерской програме 
Mamba. Порталы создавали 
у себя поддомен love.site.
ru, которое становилось 
зеркалом сайта Mamba, но 
с отличающимся дизайном. 
Сейчас такое называют White 
Label партнеркой. Например 
казиношки именно так 
создаются.

Но я другого мнения. Как 
заядлый пользователь сайта 
Mamba, заявляю вам, что 
именно виджеты на главной 
странице, а так же виджеты 
на всех страницах сайта, 
которые были видны под 
шапкой и на сайдбаре, 
были залогом успеха этого 
сайта. Дело в том, что сайт 
был дико динамическим, 
то есть менялся на глазах. 
А содержание виджетов 
зависело от ваших настроек.

Главная страница конечно 
же предлагала поиск. Как 
мы уже выяснили, если 
главная страница дает выбор, 
чтобы показать вам именно 
тот контент, который вам 
интересен, это самый первый 
шаг в построении отношений 
с посетителем сайта. Вы как 
бы говорите ему, у меня есть 
то, что тебе надо. А он такой, 
на этом сайте бывает то, что 
мне надо, зайду еще.

Но еще интереснее то, как 
в Mamba сделали виджеты. 
Посетитель видел, что 
нового появилось на сайте, 
это как бы и есть смысл 
использования виджета, 
но выборка делалась из 
твоего города а это + к 
персонализации. Это ведет к 
более тесным отношениям на 
основе более ценных данных 
для юзера.



Сначала, для гостей сайт 
определял страну по IP 
и предлагал выбрать 
город, сортируя от самых 
густонаселенных к менее. 
А после регистрации, 
за тобой закреплялся 
конкретный город. И вот ты 
уже видишь 10 последних 
зарегистрированных из 
своего города. На главной 
странице показаны самые 
красивые люди из твоего 
города по результатам свежих 
голосований. Ну и твое 
место в этом рейтинге тоже 
отображается, а рядом ссылка 
«загрузить новое фото, чтобы 
участвовать в топе». Если ты 
начнешь посещать профили, 
загружать фотографии и 
писать сообщения людям, 
то обязательно вернешься, 
чтобы проверить, что нового 
появилось конкретно для 
тебя!

Как видите, эти сайты 
в 2006 году создавали 
спрос. В отличии от 
более старых сервисов, 

которые удовлетворяли 
уже существующий спрос 
на поиск, почту и хостинг. 
Современные платформы не 
держаться на уникальности 
и фишках, как было в 2000-
х, а тупо на нейросетях, 
которые подбирают контент 
для пользователя. Но вы 
же видите, и без них можно 
было собрать нехилую 
аудиторию зависимых 
пользователей, просто давая 
людям выбор, запоминая его 
и фильтруя через этот выбор 
показываемый виджетами 
контент.

Что такое веб? Паутина. А 
паутина что должна делать? 
Мммм… вы начинаете 
понимать, паутина затягивает! 
Давайте по-русски, это сеть, 
а сетью что делают? Ловят! 
Вы еще, наверное, в легком 
шоке, но именно это и есть 
веб. Понимать это, важный 
навык, без которого ваши 
сайты обречены на провал.

Ну и на последок, дело 

веба живо по сей день даже 
на смартфонах. По сути, 
экономика внимания, это 
новое словечко, которое не 
совсем правильно отражает 
реальное положение 
вещей. Речь должна идти 
про развитие зависимости 
от сетевого ресурса, а не 
про то, что блогеры как 
базарные бабки зазывают 
всех посмотреть на свой 
канал. Блогеры тут вообще ни 
причем, они тоже зависимы от 
ресурса, куда выкладывают 
контент.

Надеюсь ответил на вопрос, 
что такое веб, как явление, 
как оно влияет на психику 
людей и каким образом это 
происходит. Выводы делайте 
сами. А я? Если сайт дарит 
мне радость и развлекает 
меня, да еще и денег не 
требует, пффф, как от такого 
отказаться? С точки зрения 
юзера, какой-то чел, который 
создал сайт на который я 
хожу, думает как его улучшить 
для меня, чтобы я остался 
довольным и не ушел. Тут 
еще подумать надо, кто 
кого использует. Думаю, все 
используют всех, как и везде.



Фотошоп трюки

1. Создаем прямоугольник для кнопки

2. Добавляем для него эффекты: Stroke, Inner Shadow, Inner 
Glow.
  2.1. Stroke 3px с цветом прямоугольника, но чуть темнее. Po-
sition: inside.
  2.2. Inner Shadow. Blending Mode: normal с углом 135 градусов 
с отключенным Global Light и цветом прямоугольника, но чуть 
светлее. Дистанция 4, Choke 100%, Size 1px. Opacity: 100%.
  2.3. Inner Glow. Blending Mode: multiply с черным цветом.

3. Добавляем слой текста с единственным эффектом Drop 
Shadow, у которого будет дистанция 1px, а спред и сайз 0. 
Угол -90 градусов с отключенным Global Light, чтобы создать 
эффект, как будто текст вырезали из кнопки.

Создание улучшенных скосов в Photoshop без 
использования эффекта Bevel & Emboss



Как добавить текстуру шума

Photoshop. Загибающийся 
лист бумаги.

Выбираем слой или создаем новый. Выделяем 
область и закрашиваем цветом.

После закрашивания фона добавляем для него 
фильтр Noise -> Add Noise

В старом вебе любили делать шераховатость и шумы. 
Несоверщенство делала фон более реалистичным.

Загибающийся лист бумаги 
делали в 2007-2012 годах. 
Сделать этот эффект в Pho-
toshop можно очень легко. 
Запоминайте.

Рисуем прямоугольник, 
включаем для него эффект 
тени… надо наверное более 
детально.

1. Создаем новый документ 
через File -> New
2. Выбираем инструмент Rect-
angle Tool.
3. Рисуем прямоугольник

4. Теперь выбираем наш 
прямоугольник в панели 
слоев.
5. Жмем на кнопку эффекты в 
той же панели
6. Выбираем эффект Stroke, 
цвет белый, Position: Inside.
7. В том же меню эффектов 
выбираем Drop Shadow, 
настраиваем как вам надо, 
сохраняем и выходим из меню 
эффектов.
8. Теперь нужно отделить тень 
от прямоугольника, чтобы 
поменять ее форму.
9. Layer -> Layer Style -> Cre-
ate new Layer
10. Выбираем слой с тенью
11. Теперь нажимаем CTRL 
+ T, чтобы включить режим 
свободной трансформации.
12. Как только вы вошли в 
этот режим, нажимаем на 
тени правый клик и выбираем 
Warp.
13. Теперь вы можете 
манипулировать формой тени, 

сделай как на картинке.
14. Теперь выбирайте 
слой тени и уменьшите 
непрозрачность на панели 
слоев -> Opacity.
15. Фон изображения должен 
совпадать с фоном сайта, 
либо нужно сохранять 
как PNG, GIF очень плохо 
работает с прозрачными 
картинками, где есть тень.
16. Сохраняйте для Web и 
вставляйте на свой сайт.



Книга: Photoshop и Dreamweaver

Сегодня у нас на полке новая 
книжка для обзора. Web-
дизайн: Photoshop и Dream-
weaver, три ключевых этапа. 
Авторы книги Колин Смит 
и Кристал Уотерс. Скачать 
ее можно в zip архиве этого 
номера журнала. Для тех, кто 
хочет делать сайты на основе 
своих коллежей и рисунков 
в Photoshop, эта книга за 
несколько часов научит вас 
этому.

Книгу я нашел 3 года 
назад, когда вновь увлекся 
вебом начала 2000-х. Она 
рассказывает о 3 этапах: 1. 
Планирование и дизайн; 2. 
Создание и оптимизация; 3. 
Доработка и публикация.

Читается она легко, а уроки 
из нее можно выполнять в 
любых версиях Photoshop и 
Dreamweaver. Напоминаю, 
что эти программы до сих пор 
обновляются и сохранили 
большинство своих старых 
функций, хоть иногда и 

приходится поискать скрытые 
инструменты и окна в новых 
версиях.

Давайте сначала уясним. 
Не смотря на медленный 
интернет, сайты содержали 
графику не только для 
иллюстрации текста, но и 
для оформления дизайна 
страниц. Photoshop умел 
оптимизировать картинку и 
делать ее вес в пределах 
1-3 килобайт. На наших 
современных мониторах 
вы почувствуете разницу, 
качество картинок получается 
хуже. Но на наших 15 
дюймовых 800x600 мониторах 
все было приемлемо.

Сначала мы планировали 
что будет на сайте, потом 
придумывали как это все 
расположить на странице, 
рисовали макет в Photo-
shop, разрезали картинку 
инструментом Slice. Аналогия 
с пиццей тут уместна, 
мы выделяли области на 

картинке, которые будут 
сохранятся как отдельные 
картинки. Киллер фичей 
Photoshop было то, что 
можно было не просто 
порезать картинки, но и сразу 
сгенерировать HTML-файл, 
где все эти части будут 
бесшовно соединены.

Потом мы открывали этот 
файл в Dreamweaver и 
редактировали его, добавляли 
текст и ссылки. В конце 
сохраняли как шаблон для 
будущих страниц сайта. При 
создании новой страницы, мы 
брали шаблон за основу.

Один раз прочитав эту книгу, 
вы сможете сделать сколько 
угодно красивых и уникальных 
сайтов и шаблонов для 
сайтов.



Как выглядели сайты на новогодние праздники

Скоро новый год, и каждый 
на своем сайте размещает 
символ этого замечательного 
праздника. Вот такими были 
сайты Яндекс, Mail.ru и List.
ru в декабре 2004 года. Это 
было лучшее время в моей 
жизни. Мне было тогда 15 
лет и я получал удовольствие 
что весь интернет его 
празднует со мной! В 12 ночи 
я дозванивался с компьютера 
по дайлапу к интернету. Его 
хватало на несколько минут, 
потом дисконект. В этот 
момент все звонили друг 
другу и телефонная сеть была 
забита.



Dreamweaver трюки

Dreamweaver: Layout View
В Dreamweaver есть способ 
рисовать макет страницы 
мышкой. Для дизайнеров 
очень подойдет такой режим, 
он называется Layout View. 
Кнопка для активации этого 
режима находится во вкладке 
Layout панели инструментов.

Есть два инструмента для 
работы в этом режиме. 
Первый это Draw Layout Ta-
ble, для рисования таблицы. 
Второй инструмент находятся 
рядом, справа, называется 
Layout Cell.

Тут важно понять суть, а не 
заучивать по шагам. Один 
инструмент рисует каркас 
таблицы, а другой рисует 
ячейки внутри таблицы. 
Сайты раньше именно так 
верстались. Сейчас тоже 
так можно делать, просто 
не принято, потому что 
сайты должны работать 
и на компьютерах, и на 
смартфонах. Но раньше было 
принято делать для каждого 
устройства отдельную версию 
сайта.



Dreamweaver: Tracing Image

Помните в детстве мы 
срисовывали через черную 
бумагу чужой рисунок? Кто 
ходил в 90-х ходил в школу, 
наверное, понял, о чем я. 
В этом уроке мы научимся 
срисовывать дизайн сайта.

1. Делаем скриншот сайта и 
сохраняем как картинку.
2. Создаем в Dreamweaver 
страницу.
3. Открываем настройки 
страницы (Page Properties).
4. Там будет настройка Trac-
ing Image.
5. Вставляем туда наш 

скриншот.
6. Настраиваем прозрачность.

Теперь у вас на фоне будет 
прозрачный фон скриншота 
сайта и вы просто верстаете 
свою страницу по его образу.



Вайбы старого веба
Попытаюсь передать вам 
вайбы старого веба, хоть это 
и будет не просто. Сейчас 
ничего и близко похожего 
нет. Наш сайт old-web.com, 
это просто блеклая тень того 
веба, как и другие подобные 
сайты и даже веб-архив. Я 
сталкивался с попытками 
рассказать о том, каким был 
интернет, но обычно авторы 
просто перечисляют факты. 
Я пытался беседовать с 
теми, кто тоже пользовался 
интернетом в начале 2000-
х, в надежде получить от 
разговора тех самых вайбов, 
не получилось.

А теперь давайте я попробую 
по памяти воссоздать вам 
вайбы, которые у меня 
возникали в начале 2000-х, 
связанные с интернетом того 
времени.

На какой портал не зайдешь, 
новости будут максимально 
скандальные. Не путать с 
современным кликбейтом, где 
делают намеки, нет, раньше 
просто в лоб и без цензуры 
было. В комментариях 
можно было чаще увидеть 
орфографические ошибки, 
это теперь на смартфоне 
исправляется автоматически, 
а тогда в каждом слове могло 
быть по 3 ошибки, на больших 
сайтах не было модерации 
комментариев, мат перемат и 
100 спамных комментариев с 
ссылками на порно-сайты или 
«волшебными кошельками» 
были нормой. Кстати, 
волшебные кошельки, это 
когда ты отправляешь 1 рубль 

на этот счет, а тебе приходит 
2 рубля, и ты берешь и 
посылаешь сразу много, а 
назад ничего не получаешь.

Порно реклама появлялась 
почти везде, потому что сайты 
ставили код рекламной сети, 
и эта сеть могла намеренно 
или просто недосмотреть 
модерацию, и пропустить 
порнуху, например на сайт 
для детей. За порнушную 
рекламу платили в 2 раза 
больше денег, и многие 
вебмастеры специально 
разрешали в настройках 
рекламной сети показ 
порнушных баннеров на 
своем сайте.

Интернет сам к тебе не 
обращался, да ты и не 
был подключен к нему все 
время. Ты планировал свое 
подключение к интернету 
заранее, покупал карточку с 
кодом и номером телефона. 
Приходил, вводил данные 
с карточки в настройках 
подключения и нажимал 
«вызов». Время стоило 
денег, ты экономил. Поэтому 
старался побыстрее открыть 
как можно больше вкладок 
с сайтами, про запас. Если 
интернет заканчивался, ты 
дочитывал заранее открытые 
страницы.

Больше всего запомнилось 
то, что на каждом сайте 
кипела жизнь, то есть все 
время была активность. Люди 
сами инициировали общение 
и предлагали помощь в 
наполнении понравившегося 

сайта. В чатах не ждали 
кто первый напишет, зашли 
и сразу написали, хотя бы 
просто поздоровались. И 
другие тут же хотя бы тоже 
здоровались. Не было такого, 
чтобы все ждали, пока кто-то 
напишет. 



Кнопка “дай рубль”
Наверное, многие думают, 
что донаты придумали для 
видеоблогеров. На самом 
деле в рунете еще в 2000-х 
была кнопка «Дай рубль» для 
сайтов. Сделали эту кнопку в 
Яндексе. Вебмастер вставлял 
код кнопки на своем сайте, 
чтобы посетители могли ему 
задонатить.

Работало это через Яндекс.
Деньги. Слово донат не 
использовали, потому что 
англицизмы не были еще 
сильно распространены 
в рунете. Это называлось 
материальной поддержкой 
сайту.

Интересное было в том, 
что размер пожертвований 
на кнопке был 3 вариантов: 
рубль, три или пять. Да, вот 
такие копейки жертвовали 
сайтам, но думаю не смотря 
на это, вебмастер был 
счастлив их получать в 2000-
х.

Сам я не пользовался никогда 
такой кнопкой, но видел такую 
на многих сайтах.



Кнопки можно делать по умному! Графические кнопки в этой 
программе можно создавать с нуля и сохранить как шаблон. 
Дальше вы вводите названия нескольких кнопок с новой 
строки, и программа создает вам сразу много кнопок с единым 
стилем, но с разными надписями. Проект сохраняется как 
шаблон. В будущем, когда вам понадобится сделать еще 
одну кнопку, вам не нужно бегать в Photoshop и по 30 минут 
рисовать 1 кнопку! Вы просто открываете проект кнопки в Crys-
tal Button и добавляете новую надпись для кнопки. Вуаля!

Ctystal Button
Кнопки можно делать по умному

В этот раз я не буду писать 
очень подробный гайд, но 
расскажу о самых важных 
моментах, остальное 
интуитивно понятно.

Прозрачность при эскпорте 
кнопки по умолчанию 
включена, но если у вашей 
кнопки есть тень, то она 
будет окрашена в выбранный 
фоновый цвет, который по 

умолчанию белый. Выход 
есть, вы можете выбрать цвет 
фона для кнопок, который 
будет повторять цвет фона 
вашего сайта. Если позже 
вы поменяете цвет фона 
на сайте, то сможете снова 
открыть сохраненный проект 
и выставить кнопкам новый 
цвет фона. Либо просто 
выключайте эффект тени 
для вашей кнопки и тогда 
они будут иметь полностью 
прозрачный фон.

В настройках текста, можно 
указывать надпись на кнопке, 
но так же можно нажать «Add» 
и добавить надпись в список 
Navbar Buttons. Вы можете 
добавить несколько надписей, 
а потом нажать File -> Navbar 
(Batch Export) и сохранить не 
одну кнопку, а сразу все.



WR-Скрипты: История одного энтузиаста, 
который подарил интернету 20+ бесплатных 
скриптов.

В середине 2000-х, когда 
создание сайтов было 
популярно, а готовых решений 
было мало, программист 
Михаил Гаврилов в свободное 
время создавал PHP-скрипты 
и бесплатно раздавал их всем 
желающим на своем сайте 
WR-Script.ru. Его сайт был 
настоящим спасением для 
начинающих вебмастеров. 
Там можно было скачать 
скрпит доски объявлений, 
форума, голосований, 
счетчика — более 20 готовых 
решений. Просто скачай и 
пользуйся. Бесплатно.

"Я просто хотел дарить 
радость людям," — говорил 
сам Михаил. И правда дарил! 
Его скрипты не требовали 
базы данных, они работали 
на PHP используя файлы. Это 
позволяло легко переносить 
их и устанавливать на 
хостинг без MySQL Один 
пользователь писал: "Массу 
скриптов пробовал, мало что 
запускалось, а эти изделия 
работают!"

Михаил постоянно развивал 
свои творения. Та же 
WR-Board начиналась 
как простенькая доска 
объявлений, а к 2011 году 
обросла личными кабинетами, 
загрузкой фото, модерацией 
— вышла уже версия 1.7 с 
кучей новых возможностей.

Забавно, что многие даже 

не знали автора — скрипты 
растаскивали по всему рунету 
без указания источника. 
Но Михаил не обижался, 
продолжал работать и 
делиться результатами. В 
комментариях люди писали: 
"Поражаюсь, бывают же 
люди, которые запросто дарят 
другим свой труд!"

Пик популярности WR-
скриптов пришелся на 2006-
2009 годы, когда альтернатив 
было мало, а качественных 
— еще меньше. Конечно, 
времена изменились, но в 
свое время проект Михаила 
помог тысячам людей сделать 
первые шаги в вебе.


